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1. Network Diagram

Connect an iR-ETN coupler and a PC to a router with Ethernet cables. The IP address of iR-ETN is set to
192.168.0.212 by default. The EasyRemotelO utility can be used to change the IP address of the iR-ETN.
On the PC, right-click on Ethernet adapter of the PC and select properties. You can set your PC to static IP
mode from [Internet Protocol Version 4 TCP/IP V4] » [General] tab. Select “Use the following IP address”
and set up a valid and non-conflicting IP address. This IP address must be configured in the same subnet,
such as 192.168.0.200.

192.168.2.1 (Default Gateway)

Wireless
router

W OoQ)
| |
Ethernet Ethernet
; Connection
192.168.0.212 Connection 192.168.0.200
(LAN 1)
IR-ETN PC
El —

Launch EasyRemote 10. The [Automatic scan] icon can scan all iR-ETN couplers located in this subnet.

a8 @

Project Window & x
A0 10/Modules  AddressMap  Parwmeter

Channel Name Type Online Yalue Project Value

Click on [Scan] button to start. The available couplers will be displayed on this dialog.

Automatic Scan X
MName IP Address Mac Address Subnet Mask
(®) Overwrits the project
() 444 o project
Scan
Select ALl Unzelect AL [0]:4 Cangel



Once the iR-ETN is found, go to [Online] » [Change IP]. Enter a new static IP address and a sub mask.
fHl EasyRemotelO

File Edit WView Online Tools Help

8] @_ |E Automatic Scan Shift+5 4
Project Window [l.’_’.l Compare with Offline Shift+C
A
v B RETN (S [|+ Download |
il #1:iR- Download All [
il #2:iR 2 Change IP address @
il #3-ir [+ Upload A
Upload All o WMac Address : 00-0C-26-01-02-04
. D -
SR B [P Address: 197 | 168 2 183
Change IP ' ' '
User-Defined Temp. Table sub Magk 255 . 255 ) 251 ) 1]
g Start Monitoring Shift+M [ 0K ] [ Pl
"y Monitaring Once
Stop Maonitoring Shift+O
I I

Click [Automatic scan] again, and the iR-ETN will be found with the specified IP address.

Automatic Scan @
Name IP Address Mac Address Sub Mask
[@] iR-ETN 192.168.2.183  00-0C-26-01-02-04 255.255.252.0 ©) Overwrite the project
Add to project
Scan
< T »
OK Cancel

Set the IP address of the PC to DHCP mode. Now all the devices are configured in the same subnet. The
current network will be similar to the below diagram.

192.168.2.1 (Default Gateway)

Wireless
router
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| |
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2. Power Consumption

The iR-ETN coupler supplies power for each connected 10 module. To avoid the power requirements
exceeding the power supply, you can calculate how much power is required from your |0 modules.

Type Model Name | Consumption(5V) | Power Supply(5V)

Coupler iR-ETN 220mA/1.1 W 2A/10w

Digital I/O | iR-DM16-P 130mA/0.65 W
iR-DM16-N 130mA/0.65 W
iR-DQO8-R 220mA/1.1W
iR-DQ16-N 205mA/1.02 W
iR-DQ16-P 196mA/0.984 W
iR-DI16-K 83mA/0.418 W

Analog 10 | iR-AQ04-VI 65mA/0.325 W
iR-Al04-VI 70mA/0.35 W
iR-AMO06-VI 70mA/0.35 W
iR-Al04-TR 65mA/0.325 W

Motion iR-PUO1-P 108mA/0.54 W

iR-DM16-N iR-DQO8-R iR-DQ16-P
iR-DM16-P iR-DQ16-N iR-DI16-K

220mA 130+130+220+205+196+83
=964

Power consumption: 220 + 964=1184mA
Power supply: 2000mA

Supply > Consumption

Power is enough to supply all the 10 modules.



The power consumption can be known by selecting [iR-ETN] » [Parameter] tab.

[Current Power Consumption]- indicates the power consumed by each module and coupler.
[Power Consumption] - indicates the power consumption of the selected device.

fHl EasyRematelO
File Edit View Online Tools Help

S|

Project Window

v B} iR-ETN (192.168.1.214)
il #1:iR-AMOB-VI
il #2:iR-AMOB-VI

e WF e [ °8

10/ Modules  Address Map Parameter

Chenne] Name

v iR-ETM (192.168.1.214)
Vendor Name
Product Code
Host Mame
Firmware Revision
Hardware Revision
Power Consumption
Current Power Consumption
Power Supply
Life Guard Time
iBus Continue Run
RunStop Pin
Mumber of Modules
Paint of Digital Input
Paint of Digital Output
Mumber of Analog Input
Mumber of Analog Output

Onling Valug

Weintek
0x0702
iR-ETM
1.01.0
1.000
1.1W
1.8W
10W
Oms
OFF
Disable
2

Q
Q
8
4

Project Value

iR-ETM

Oms
OFF
Dizhble

If power is not sufficient, an error will be displayed on the Log message window.




3. EasyRemotelO

EasyRemote I/O is a utility used for setting up iR-ETN coupler and |10 module connected to iR-ETN, which
includes changing the IP address of the iR-ETN, setting parameters, monitoring 10s, turn on outputs, and
changing analog values.

il EasyRemotelD - a ®
File Edit View Online Tool: Help
SRR BB R BB _ _ _ _ _ ____________ ,
I tH =i *I 10/ Modukes  AddwssMap  Porsmetsr 1
||~ B r-ETN(192.168.1.214) Iy
i =1:iR-AMOSM I Chonines | Nons Ty Orndine ¥ alne: Fromet Falue 1
I il =2 iR-AI04-TR I ¥ R-ETN (192.168.1.214) |
| il =3 R-DM1G-P 1 #1: iR-AMOG-VI Al AD
I #2: iR-A04-TR Al |
| 1 #3: iR-DM16-P D1/ DO 0x00 I
|
I I ,
| g
|
| l
|
| h
|
| h
|
| l
|
| h
1| Device list I Device inf ti ,
' evice intormation |
| | |
| h
|
| h
’ |
e g g g e e a
Log Mezmge & x
e — o 1
I Date Time Message
| 2019-04-11 10:00:05.933 Auto scan is successfully completed.
| 2019-04-11 10:00:02.309 Aute scan is suecessfully completed, No devices found.

I 2019-04-11 09:59:35.870 Auto scan is successfully completed. No devices found.

| 2019-04-11 09:44:30,792 EasyRematelO is started, ProductVersion:1.2.0.13

Device list- Lists available iR-ETN couplers. The I0 module can be selected under each iR-ETN once
connected.
Device information- It includes [IO /modules] tab, [Address] tab, and [Parameter] tab.
[10 /modules] tab- can monitor the status of 10s, toggle bits, and write analog values.
[Address map] tab- displays Modbus mapping table for IOs.
[Parameter] tab- lists the available parameters.
Log message- displays logs and errors.

Note: In this user manual, EasyRemotelO version 1.2.0.13 is used.



Toolbar overview

S

(Tools from left to right.)

Tool Name

== ﬁ E U:l EIi Eli CHO -j—[j}-

Descriptions

Open

Save

Add coupler
Add module
Move up
Move down
Delete

Scan

Compare with Offline

Upload

Upload all
Download
Download all
Monitor once
Start monitor
Stop monitor

Other tools
Tool Name

Opens an old project. (*.eriop file)

Saves this project. (*.eriop file)

Adds a coupler to the Device list.

Adds a module under the selected coupler.

Moves up the selected module to adjust slot number.

Moves down the selected module to adjust slot number.

Deletes the selected coupler or module.

Scans all the couplers located in this subnet.

Compares this project edited in EasyRemotelO to the online devices.
Reads values from a module. The values will be displayed in [IO/ Module]
tab » [Online Value] column.

Reads values from all the modules.

Writes the value from [Project Value] column to a module.

Writes all the values from [Project Value] column to all the modules.
Monitors devices once.

Starts monitoring devices

Stops monitoring devices.

Descriptions

Export tag
Rename
Change IP

Special command

Modbus

User defined Temp. table

Exports tags which maps to Modbus address.

Changes name of the modules or couplers.

Changes IP address of couplers.

Sends special command to a coupler or module.

Runs a Modbus TCP/IP master on the PC.

This function will be available if IR-Al04-TR module is used.



Export tag
This tool allows you to export tags to .CSV file for reference. This CSV file can be imported to EasyBuilder
pro and deploy tags.

In EasyRemotelO, go to [File] » [Export tag]. Then navigate to a folder you want to save the CSV files. The

number of couplers in this project determines the number of CSV files generated by EasyRemotelO.
{Hl EasyRemotelO

File Edit View Online Tools Help

Open Ctrl+0 o E 12 §s fils 0 08
] 3 New Ctrl+N 8
H Save Ctrlss 10 / Modules Address Map Parameter
] saveas 19 Channel Name Type Online Valve Project Value
Export Tag v {iR-ETN (192.168.1.214)
il #3:iR-DM16-P #1:iR-AMO06-VI Al/AO
#2:iR-AI04-TR Al
#3:iR-DM16-P DI/ DO 0x00

The CSV file describes tag name, address type defined by EasyBuilder pro, and Modbus starting address.

13 iR-ETN.Point of Digital Input Ax 10035
14 |iR-ETN.Point of Digital Output Ax 10036
15 iR-ETN.Number of Analog Input Ax 10037
16 iR-ETM.Number of Analog Output Ax 10038
17 iR-ETM.#1: iR-AMO6-VI.Product Code Ax 30000
18 iR-ETN.#1: iR-AMOG6-VI.Firmware Revision Ax 30001
19 iR-ETM.#1: iR-AMO6-VI.Hardware Revision Ax 30002
20 iR-ETN.#1: iR-AMOG-VI.Power Consumption Ax 30003
21 iR-ETN.#1: iR-AMO6-VI.Point of Digital Input Ax 30038
22 iR-ETM.#1: iR-AMOG-VI.Point of Digital Output Ax 30039
23 |iR-ETN.#1: iR-AMO6-VI.Number of Analog Input Ax 30040
24 iR-ETN.#1: iR-AMO6-VI.Number of Analog Qutput Ax 30041
25 iR-ETM.#1: iR-AMOG-VI.Output Mode #0 Ax 20000
26 iR-ETN.#1: iR-AMO06-VI.Output Mode #1 Ax 20001
27 iR-ETM.#1: iR-AMO6-VI.Output Scale Range Upper Limit #0 Ax 20004
28 |iR-ETM.#1: iR-AMOB-VI.Output Scale Range Upper Limit #1 4x 20005

In Easybuilder pro, go to [System Parameters] and add the “Weintek Remote 10( Modbus TCP IP)” driver.
Click on [Import Tags] to import the CSV file.

No. Name Location  Device type Interface IIF Protocol
= Local HMI Local HMI Local cMT3072 (102... - -

» Weintek Remot... e o G

New L. peete Settigs...




Rename

This tool allows you to change the name of modules and couplers for identifying devices.

In EasyRemotelO, select a module or coupler you want to rename. Go to [Edit] » [Rename].

[l EasyRemotelO

File = Edit View Online Tools Help

Add
Projec: Move Up
[ Move Down
m Delete
Rename

Change IP (Offling)

Shift+Up
Shift+Down
Del

Ctrl+R

21 s i+ e

[0/ Modules  AddressMap  Parameter
Channel Fame Type Cinline ¥alue Project Value
v iR-ETN (192.168.1.214)
#1: iR-ANOB-VI Al fAD
#2: iR-AI04-TR Al
#3:iR-DM16-P DI /DO 000

Enter a new name and click OK button.

Special command

This tool allows you to send special commands to a coupler or module, such as reset to factory default.

EasyRemotelO

HNew name:

iR-ETN_STATION]|

Cancel

In EasyRemotelO, go to [Online] » [Special Commands]. The available special command will be displayed.
Select a command and click [Start].

[l EasyRemotelO

File Edit View Online Tools

Help

[Z‘ @_ |E[)‘ Automatic Scan

Project Windaw ”2' Compare with Offline

il #1:iR-
il #2:iR-

v B iR-ETN (1S |+ Download

il #3:r-1 ]+ Upload

Upload All

Download All

Special Commands
Change IP

User-Defined Temp. Table

= 0 Start Monitoring
"y Monitaring Once

Stop Monitoring

Shift+s s
Shift+C
114
9.
A
All
D1
Shift+M
Shift+O

Special Commands

Restart Device

Restart iBus

Reset to default(except IP Setting)

Reset to manufacture value (#1: iIR-AMOG-VI
Reset to manufacture value (#2: iR-AI04-TR)

Send

Camncel

10



Modbus

This tool allows you to run a Modbus TCP/IP master on the PC. To use this function, go to [Tools] »
[Modbus].

Maodbus Communication

Communication Setup

[IP Address]- Enter IP address of the coupler you want to
access.

[Pre_defined]- You can bring up the tag list. Once a tag is
selected, the corresponding function code, address,
length will be filled in the boxes.

IP Address : 192 . 168 . 1 . 214 SlaveID: 0

Protocol : | Modbus TCP

Pre_defined : | [1.Read] Vendor name string ~

[Function]- Modbus function code.

Fuction = e v [Address]- Modbus starting address.

Address : Quantity : [Quantity]- Length of the data.

Wirite : Send
The result will be displayed on [Response] box once
clicking on [Send] button. Select a data type to interpret
Response this data.

| Weintek |

(O Hex (Obec (®) ASCII (BN

Exit

For example, use this tool to read the parameter “Input Mode #0,” which is channel 0 of the analog input.
Function: Read Holding Registers.

Address: 20020

Quantity: 1

Data type: decimal

The constant value five on the Response box indicates 4-20mA signal.

10/ Modules  Addoess Map Parumeter

Choanre] Nume Ormline ¥alue Froject Valoe
v #10iR-AMODE-V]
Product Code 0x0635
Firrnware Revision 1.000
Hardware Revision 1.000
Power Consumption 035w
Point of Digital Input o
Point of Digital Output 0
Mumber of Analog Input 4
MNumber of Analog Cutput 2
Analog Output Eror Mode #0 Keep last value Keep last value
Analog Output Eror Mode #1 Keep last value Keep last value Modbus Communication
Analog Output Errer Value #0 [+] 0
Analog Output Error Value #1 0 0 _
Output Mode 20 210V 0w = Communication Setup .
Output Mode 21 10V +H0V - PaAddess: | 192 . 168 . 1 . 212 | SaveD: 0
Output Scale Range Upper Limit #0 16000 16000 - B
Output Seale Range Upper Limit #1 32000 32000 Protocol: | Modbus TCP
Output Scale Range Lower Limit 0 -32000 -32000
Output Scale Range Lower Limit 21 -32000 -32000
Output Update Time 80 0 0
Cutput Update Time #1 0 ] Pre_defined: |[LRead] Digital input v
Input Mode #0 4-20mA 4-20mk =
Input Mode #1 Close Clox i Funcion:  Read Holdng Registers W
Input Mode #2 Close Cloz= =
Input Mode #3 Close Close - Address: (20020 | Quantity : |1
Input Scale Range Upper Limit #0 100 100 .
Input Scale Range Upper Limit 21 32000 32000 Write : Send
Input Scale Range Upper Limit #2 32000 32000
Input Scale Range Upper Limit 23 32000 32000
Input Scale Range Lower Limit %0 0 0
Input Scale Range Lower Limit 21 -32000 -32000 Respanse
Input Scale Range Lower Limit #2 0 0 -
Input Scale Range Lower Limit #3 -32000 -32000 1Z
Input Filter Frame Size #0 10 10
In:::ﬁller Frame Size #1 10 10 CHex @lpec Clescr @]
Input Filter Frame Size #2 10 10

Input Filter Frame Size #3 10 10

PMaximum Value #0 5249 |Rewst E

11



4. EasyRemotelO- Controlling 10 Module
Digital 10

An iR-DM16-P (8 DI and 8 D0) is placed on slot #3. To know status of the digital 10, click on[Online] » [Start
Monitoring] and then click on the iR-DM16-P under the iR-ETN coupler. The status of the 10 will be listed on
[10 / Module] tab.

File Edit View Online Tools Help

A s [ Bs o
FProject Window g X
10/ Modules Address Map Parameter
~ E} iR-ETN (192.168.1.214)
il #1: iR-AMOB-VI Channe] Neme Type Online Value Froject Value
fll #2 R-AO04-TR R A
il #3:.iR-DM16-P Digital Input #0 DI 0
Digital Input #1 DI 0
Digital Input #2 DI 0
Digital Input #3 Dl 0
Digital Input #4 DI 0
Digital Input #5 DI 0
Digital Input #6 DI 0
Digital Input #7 Dl 0
Digital Qutput #0 DO 0 0
Digital Qutput #1 DO 0 0
Digital Output #2 DO 0 0
Digital Output #3 DO 0 0
Digital Output #4 DO 0 0
Digital Output #5 DO 0 0
Digital Qutput #6 Do 0 o
Digital Qutput #7 Do 0 o

To force the digital output ON, enter 1 to the [Project Value] column.
[l EasyRemotelO

File Edit View Online Tools Help

A B+ B e og
Project Window 3 X
10/ Modules Address Map Paramster
~ B} iR-ETN (192.168.1.214)
i #1:iR-AMOB-VI Channe] Namme Type Online Value Project Value
il #2. iR-AID4-TR v #3:R-DM16-P
fl #3:RDM16P Digital Input #0 DI 0
Digital Input #1 Dl o
Digital Input #2 DI 0
Digital Input #3 DI 0
Digital Input #4 DI 0
Digital Input #5 ]} ]
Digital Input #6 DI o
Digital Input #7 DI 0 —
Digital Qutput #1 DO o o

Click [Download]. Channel 0 of digital output will be turned ON. The [Online Value] column shows the
current status of digital 10. (1=ON, 0=0FF)

EasyRemotelO
File Edit View Online Tools Help

5 N og

Project Window A X
10 { Modules Address Map Parameter

v El iR-ETN (192.168.1.214)
Eﬂ #1. IR-AMOB-VI Channel Name Tupe Cnline Falue Project Value
il #2.iR-AI04-TR v #3:iR-DM16-P
il #3:iR-DM16-P Digital Input #0 DI 0
Digital Input #1 DI 0
Digital Input #2 DI 0
Digital Input #3 DI 0
Digital Input #4 DI 0
Digital Input #5 DI 0
Digital Input #6 DI 0
Digital Input #7 DI 0
Digital Output #1 Do a o

12



Analog input

In this demonstration, iR-AM06-VI (4 Al and 2 AQ) is placed on slot #1. An RTD Pt100 with transmitter
(Range:-50-100 °C, Output:4-20mA) is being connected to the analog input of the module. The wiring

diagram is shown below.

3wire

out

24V

Current
Sensor

24vde

ov

In EasyRemotelO, go to [Parameter] tab. Configure the Input mode, Upper limit, and Lower limit.

Input Mode #0:4-20mA
Input Scale Range Upper Limit #0: 100
Input Scale Range Upper Limit #0: -50

il EasyRemotelO
File Edit View Online Tools Help
H e B il [ '8

Project Window
10/ Modules  Address Map Parameter

[v ER iR-ETN (192.168.1.212)

Project Value

#1- iR-AMO6-VI Channel Name Online Value

[ nput Mode #0 2-20mA 420mA -
Input Mode #1 Close Closz i
Input Mode #2 Close Closs -
Input Mode #3 Close Close b

| Input Scale Range Upper Limit #0 100 100
Input Scale Range Upper Limit #1 32000 32000
Input Scale Range Upper Limit #2 32000 32000
Input Scale Range Upper Limit #3 32000 32000

|_Input Scale Range Lower Limit #0 -50 -50
Input Scale Range Lower Limit #1 32000 ~32000
Input Scale Range Lower Limit #2 0 [
Input Scale Range Lower Limit #3 -32000 -32000

Mode

-
- High limit
p-

Low limit

Click [Download]. The settings will be loaded to the module. To monitor the value, click on [Online] » [Start
Monitoring] and then go to the [iR-AMO06-VI] » [IO / Module] tab.

fHl EasyRemotelO
File Edit View Online Tools Help

H i+ [ [ e
Project Wind,
2275 o 10/ Modules Address Map Parameter
v i} iR-ETN (192.168.1.212) | pa— .
il #1:iR-AMOS-VI asuie] e e
v #1:R-AMO6-VI
Analog Input #0 Al
Analog Input #1 Al
Analog Input #2 Al
Analog Input #3 Al
Analog Cutput #0 AO
Analog Output #1 AO

Onling Value

8

00 0O 0 0O =

Project Value

13



Analog output

In this demonstration, iR-AM06-VI (4 Al and 2 AQ) is placed on slot #1. A VFD analog input (Input: 4-20mA,
Range: 0-60Hz) is being connected to the analog output of the module. The wiring diagram is shown below.

.-

-10V-10V + {
e wia
iy Y L aG | AG

] .

24V | oV

+| -

24V

To control the motor speed by sending frequency source, configure the Output mode, Upper limit, and
Lower limit, and Output Update Time in EasyRemotelO.

Output Mode #0: 4-20mA

Output Scale Range Upper Limit #0: 100 %

Output Scale Range Upper Limit #0: 0 %

Output Update Time #0: 1000 (10s= 1000*10ms)

fHl EasyRemotel - O X

File Edit View Online Tools Help

BER <0 B@LBLE <%

il Wndow 10/Modules  AddressMap  Pavameter
[v B R-ETN (192.168.1.214) |
#1:iR-AMOE-VI Channel Neme Online Velue Froject Value A Mod
il #2.iR-A04-TR [ Ouputiiode 50 Tk 7] ode
il #3:iR-DM16-P Output Mode #1 Close - ) o
| Output Scale Range Upper Limit #0 100 ] High limit
Qutput Scale Range Upper Limit #1 32000
Output Scale Range Lower Limit #0 0 ] Low ||m it
Qutput Scale Range Lower Limit #1 -32000
1 Qutput Update Time #0 1000 ]
Output Update Time #1 0 Soft-start

Click [Download]. The settings will be loaded to the module.

To control the motor speed, click on [Online] » [Start Monitoring] and then go to the [iR-AMO06-VI] » [IO /
Module] tab. Write a constant value to the [Project Value] column. Click [Download] to write the value to
the module.

EHl EasyRemotelO
File Edit View Online Tools Help
S| Ws [ fs °g8

Project Window 5 x
10/ Maodules Address Map Parameter

~ E} iR-ETN (192.168.1.214)
il #1:iR-AMO0B-VI Channe] Hame Type Online Value Fuoject Valus
il #2:iR-Al04-TR v #1:iR-AMO6-VI
il #3:iR-DM16-P Analog Input #0 Al 0
Analog Input #1 Al 0
Analog Input #2 Al 0
Analog Input #3 Al 0
Analog Output #0 AO 80 =]
Analog Output #1 AO 0 0

14



Temperature module

In this demonstration, iR-VI04-TR (4 Temperature inputs) is placed on slot #1. A K type thermocouple is

being connected to the input of the temperature module. The wiring diagram is shown below.

iR-AI04-TR

Shoelded cable

-

MO+

MO-

)

LO-

M1+

Ml-

s

L1-

M2+

M2-

S

L2-

M3+

M3-

L3-

L

24V

oV

+ -

Input Mode #0: K
Unit of Temperature: Fahrenheit
Click [Download]. The settings will be loaded to the module.

fHl EasyRemotelO
File Edit View Online Tools Help
H s il s @& '8

Project Window & %
10/Modules  AddmessMap  Parameter

[~ TER iR-ETN (192.168.1.214)

2|4V
In EasyRemotelO, go to [Parameter] tab. Select the input mode and unit of temperature.

il #1:iR-AI04-TR Channel Name Onling Yalve Project Yalue
|_input Mode #0 K K 2
Input Mode #1 Close Clos 7
Input Mode #2 Close Cloze v
Input Mode #3 Close Close =

| Unit of Temperature

Fahrenheit(°F)

Fahrenheit(*F)

Temperature Offset #0
Temperature Offset #1

0
o

0
0

To monitor the temperature, click on [Online] » [Start Monitoring] and then go to the [iR-Al04-TR] » [IO /
Module] tab. The raw data is displayed as 717, which is 71.7 °F (one digit after the decimal point).

[H] EasyRemotelO
File Edit View Online Tools Help
H s [ @ '8

FProject Wmndow & X
10/ Modules  AddvessMap  Parameter

~ El iR-ETN (192.168.1.214)

(]

X

il =#1:iR-AI04-TR Chaunel Nasne e
VELRADGTR
Analog Input #0 Al
Analog Input #1 Al
Analog Input #2 Al
Analog Input #3 Al

Ounline Value

77
0
0
0

Project Value

15



5.iR-ETN 10 Module Mapping to Modbus

Digital I0 modules

Module name The number of The number of
digital inputs (DI) | digital outputs (DO)

iR-DI16-K 16 0

iR-DM16-P 8 8

iR-DM16-N 8 8

iR-DQ16-P 0 16

iR-DQ16-N 0 16

iR-DQO8-R 0 8 (Relay)

Digital 10 modules mapping to Modbus address

Name Address (HEX) Address (DEC) Read/Write | Supported Modbus | Descriptions
function code
Digital Input 0x0000-0x0200 | 0-512 R 2 Read in bit
0x0320-0x035F | 800 - 863 R 3,23 Read in word
Digital Output | 0x0000-0x0200 | 0-512 R 1 Read in bit
0x0000-0x0200 | 0-512 W 5,15 Write in bit
0x0360-0x039F 864 - 927 W 6, 16, 23 Write in word

Analog 10 modules

Module name

The number of
analog inputs (Al)

The number of
analog outputs (AO)

iR-Al04-VI 4 4
iR-AMO06-VI 4 2
iR-AQ04-VI 0 4
iR-Al04-TR 4 (Temperature) | O

Analog 10 modules mapping to Modbus address

Name Address (HEX) | Address (DEC) | Read/Write | Supported Modbus
function code
Analog Input 0x0000-0x00FF | 0-255 R 3,4,23
Analog Output | 0x0100- OxO1FF | 256 - 511 R 3,23
w 6, 16, 23
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Example of Digital IO mapping

Slot number

Module name

Bits for input (HEX)

Bits for output (HEX)

#0

iR-ETN

#1

iR-DM16-P

0x0000 - 0x0007

0x0000 - 0x0007

#2

iR-DM16-N

0x0008 - 0x000f

0x0008 - 0x000f

You can know the |10 mapping by selecting the iR-ETN coupler and click on [Address Map] tab.
2:

il EasyRemotelO

File Edit View Online Tools Help

H BN
Project Window
v 1} R-ETN(192.168.1.214)

il #1:iR-DM16-P
il #2iR-DM16-N

i

B
& X
10/ Modules

Slot# / Model

R-ETN (192.168.1.214)

v #1:iR-DM16-P

v #2:iR-DM16-N

Address Mep

©

= o

Addresses in Hex format

Parsmeter

x

Input Word

0x0320/00
0x0320/01
0x0320/02
0x0320/03
0x0320/04
0x0320/05
0x0320/06
0x0320/07

NoUuAsEwWN=O

NoOUVAWN=O

0x0320/08
0x0320/09
0x0320/0a
0x0320/0b
0x0320/0¢
0x0320/0d
0x0320/0e
0x0320/0f

NoOUVBEWN-O

NoOUVBEWN-O

Input Bit Output Word
0x0000
0x0001
0x0002
0x0003
0x0004
0x0005
0x0006
0x0007
0x0360/00
0x0360/01
0x0360/02
0x0360/03
0x0360/04
0x0360/05
0x0360/06
0x0360/07
0x0008
0x0009
0x000a
0x000b
0x000¢
0x000d
0x000e
0x000f
0x0360/08
0x0360/09
0x0360/0a
0x0360/0b
0x0360/0¢
0x0360/0d
0x0360/0¢
0x0360/0f

Output Bit

0x0000
0x0001
0x0002
0x0003

0x0005

0x0008
0x0009
0x000a
0x000b
0x000¢
0x000d
0x000e

To use Codesys to control 10s, go to [Modbus TCP Slave] » [Modbus Slave Channel] tab. Configure Modbus

channels.

General

Modbus Slave Channel

Modbus Slave Init

ModbusTCPSlave Parameters

ModbusTCPSlave [fO Mapping

Status

Information

Mame Access Type
0 DM1g-N_INPUT Read Discrete Inputs (Function Code 02)
1 DM1s-N_OUTPUT Write Multiple Coils {Function Code 15)
2 DM16-P_INPUT Read Discrete Inputs {(Function Code 02)
3 DMi6F_QUTPUT Write Multiple Coils (Function Code 15)

Trigger READ Offset | Length
Cydic, t#100ms 1630000 8

Rising edge

Cydic, t#100ms | 16#0008 8

Rising edge

Error Handling
Keep last Value

Keep last Value

WRITE Offset

1620000

16#0008

Offset must be HEX

Length  Comment

3

8
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Example of analog 10 mapping

Slot number

Module name

Words for input (HEX)

Words for output (HEX)

#0

iR-ETN

#1

iR-AMO06-VI

0x0000 -0x0003

0x0100 - 0x0101

#2

iR-AMO06-VI

0x0004 -0x0007

0x0102 - 0x0103

You can know the 10 mapping by selecting the iR-ETN coupler and click on [Address Map] tab.

tHl EasyRemotelO = o X
File Edit View Online Tools Help
A &N i & 21 8 :
Addresses in Hex format
Propect Window
10 / Modules Address Mop Parameter
v i} R-ETN(192.168.1.212)
Ul #1:RAMOGM Slot# / Model Che InputWord  Input Bit OutputWord  Output Bit
il £2:iR-AMOG-VI iR-ETN (192.168.1.212)
v #1:iR-AMO06-VI 0 0x0000/00
1 0x0001/00
2 0x0002/00
1 3 0x0003/00
i 0 0x0100/00
1 0x0101/00
v #2iR-AM06-VI 0 0x0004/00
1 0x0005/00
2 0x0006/00
3 0x0007/00
0 0x0102/00
1 0x0103/00

To use Codesys to control 10s, go to [Modbus TCP Slave] » [Modbus Slave Channel] tab. Configure Modbus
channels.

| General Mame Access Type Trigger READ Offset | Length  ErrorHandling | WRITE Offset | Length  Comment
0 SLOT1_INPUT Read Holding Registers (Function Code 03) Cydic, t#100ms 16#0000 4 Keep last Value AMDE-VI
| Modbus Slave Channel 1 SLOTLOUTPUT  Write Multiple Registers (Function Code 16)  Rising edge 16#0100 2 AMOB-VT
Modbus Slave Init 2 SLOTZ_INPUT Read Holding Registers (Function Code 03) Cydic, t#100ms 16#0004 4 Keep last Value AMDBE-VI
3 SLOT2_OUTPUT Wirite Multiple Registers (Function Code 16) Rising edge 1620102 2 AMOB-VT

ModbusTCPSlave Parameters
ModbusTCPSlave I/0 Mapping Offset must be HEX
Status

Information
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Example of digital and analog 10 mapping

Slot numer | Module name | Words for input (HEX) Words for output (HEX)

#0 iR-ETN | —— ] e

#1 iR-AMO06-VI 0x0000 - 0x0003 0x0100 - 0x0101

#2 iR-Al04-TR 0x0004 — 0x0007 | -----

#3 iR-DM16-P 0x0000 - 0x0007 0x0000 - 0x0007

#4 iR-DM16-N 0x0008 - 0x000f 0x0008 - 0x000f

You can know the |10 mapping by selecting the iR-ETN coupler and click on [Address Map] tab.
2.

Addresses in Hex format

Pt Winkow O3 | 10/ Motui  AddouMep | Pammenr
v i R-ETN (192168.1.212)
il #1.iR-AMOSM for® / M Che Input Word Input 8t OutptWord  Output Bit
il 2 iR-A0STR R-ETN (192.168.1.212)
0 #3.ROM16-P v #1:R-AMOSM 0 0x0000/00
il #4:R-OM16-N 1 0x0001/00
2 0x0002/00
3 0x0003/00
0 0x0100/00
1 1 0x0101/00
d v 82 iRA04-TR 0
1
2
3
v #£3.R-OM16-P 0 0x0000
1 0x0001
2 0x0002
3 0x0003
4 0x0004
5 00005
6 00006
7 0x0007
° 0x0360/00 00000
1 0x0360/01 0x0001
2 0x0360/02 00002
3 0:0360/03 020003
B 0x0360/04 040004
5 0x0360/05 020005
6 0x0360/06 00006
7 0x0360/07 00007
v 84 R-DMI6-N ° 0x0320/08 00008
1 0x0009
2 0x0008
3 0x000b
4 0x000¢
5 0x000d
6 0x000e
7 0x000f
0 0x0360/08 040008
1 0x0009
2 0x0008
3 0x000b
4 0x000¢
s 0x000d
6 0x000e
7 0x000f

To use Codesys to control 10s, go to [Modbus TCP Slave] » [Modbus Slave Channel] tab. Configure Modbus
channels.

| General Name Access Type Trigger READ Offset | Length  ErrorHandling | WRITE Offset | Length  Comment
0 SLOT1_INPUT Read Holding Registers (Function Code 03) Cydic, t#100ms 1620000 4 Keep last Value AMDE-VT
| Madbus Siave Channel 1 SLOTLOUTPUT  Write Multiple Registers (Function Code 16)  Rising edge 1650100 2 AMDEVT
Modbus Slave Init 2 SLOT2_INPUT Read Holding Registers (Function Code 03) Cydic, t#100ms 160004 4 Keep last Value AMO4-TR
3 SLOT3_INPUT Read Discrete Inputs (Function Code 02) Cydlic, t#100ms 160000 8 Keep last Value RDM16F
ModbusTCPSlave Parameters 4 SLOT3_OUTPUT Write Multiple Coils (Function Code 15) Rising edge 16#0000 8 RDM16P
5 SLOT4_INFUT Read Discrete Inputs (Function Code 02) Cydic, t#100ms 160008 8 Keep last Value R-DM16-M
ModbusTCPSlave IO Mapping & SLOT4_OUTPUT Wirite Multiple Coils (Function Code 15) Rising edge 16#0008 8 R-DM 16

Status

Offset must be HEX

Information
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6. Module Register

Each analog module has its module registers (parameters). The parameters may vary based on the analog 10
modules you have. The available parameters can be known by selecting [Parameter] tab.

10/ Modules  Address Map Farameter

.Ch.nnm] Haare il Value Project Valoe Al
Output Mode #0 10V oy -
Output Mode #1 +10v oy 7
Output Scale Range Upper Limit £0 32000 32000
Output Scale Range Upper Limit #1 32000 32000
Output Scale Range Lower Limit #0 -32000 -32000
Output Scale Range Lower Limit #1 =32000 =32000
Output Update Tirme 20 o o
Qutput Update Time #1 (] o
Input Mode #0 4-20ma 4-20mA -
Input Mode #1 Close Clece %
Input Mode #2 Close Clow =
Input Mode #3 Close Clos b
Input Scale Range Upper Limit #0 100 100
Input Scale Range Upper Limit 1 32000 32000
Input Scale Range Upper Limit #2 32000 32000
Input Scale Range Upper Limit #3 32000 32000
Input Scale Range Lower Limit #0 ] o
Imput Scale Range Lower Limit %1 -32000 -32000
Input Scale Range Lower Limit #2 (4] o
Input Scale Range Lower Limit #3 -32000 =32000 =

Channel Hame COnline Value Project Value
Input Filter Frame Size #2 10 10
Input Filter Frame Size #3 10 10
Maximum Value #0 49 Reset
Maximum Value #1 0 |Rest
Maximum Value #2 0 |Rest
Maximum Value #3 0 |Reset
Minimum Value #0 -1 |Resst
Minimum Value #1 0 |Rest
Minimum Value #2 0 |Rest
Minimum Value #3 0 |Resst
Error Code ONE
Conversion time Mormal Nomoal i

“ Enable/Disable Detect Analog Channel
Detect Analog Input Channel #0 Enable Enable
Detect Analog Input Channel #1 Enable Enable
Detect Analog Input Channel #2 Enable Enable
Detect Analog Input Channel #3 Enable Enable
Detect Analog Output Channel #0 Enable Enable
Detect Analog Output Channel #1 Enable Enable

To read and write these parameters via Modbus protocol, you need to know their Modbus addresses.
The starting register of slot #1 10 module is 20000. The number words of the parameters are 500.
» The starting registers of the following modules are 20000 + (slot number -1) * 500
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Mapping table for Module registers

Slot Modbus address (DEC) | Modbus address (HEX)
number

#0 (IR-ETN) [ oomeomeeeee | e

#1 20000-20499 4E20-5013

#2 20500-20999 5014-5207

#3 21000-21499 5208-53FB

#4 21500-21999 53FC-55EF

#16 27500-27999 6B6C-6D5F

Function code for reading Module registers: 3, 4, 23
Function code for writing Module registers: 6, 16, 23

Module register= (starting register of module) + (register number)
Please refer to Appendix A to know the register number for iR-Al04-VI, iR-AMO06-VI, iR-AQ04-VI, and iR-
AlO4-TR.

For example,

The temperature module is placed on slot #1. The starting register is 20000.

To read and write the parameter for channel 0 temperature offset, (which is assigned to register number
20) the Modbus register would have to be set to 20020 (=20000+20).

Channel 1 temperature offset is 20021 (=20000+21)
Channel 2 temperature offset is 20022 (=20000+22)
Channel 3 temperature offset is 20023 (=20000+23)

Example of configuring Modbus channels.

General MName Access Type Trigger READ Offset  Length  ErrorHandling WRITE Offset  Length
0 Read Temp Channel Read Holding Registers (Function Code 03) Cydic, t#100ms 1670000 4 Set to ZERQ

Modbus Slave Channel
1 Read Temp Offset Read Holding Registers (Function Code 03) Cydic, t#100ms 16#4E34 4 Set to ZERO
2 Write Temp Offset Write Multiple Registers (Function Code 18) Rising edge 16#4E34 4

Modbus Slave Init

ModbusTCPSlave Parameters

ModbusTCPSlave If0 Mapping

Status

Information

ChO Read Temp Chanel: Reads the values of each temperature channel
Ch1 Read Temp Offset: Reads the offset of each temperature channel
Ch2 Write Temp Offset: Writes the offset of each temperature channel
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Example of Module register mapping

Slot Module The number | The number | The number | The number of
number | name of DI of DO of Al AO
#0 iR-ETN 0 0 0 0
#1 iR-AQO4-VI |0 0 0 4
#2 iR-Al04-VI 0 0 4 0
#3 iR-DQ16-P 8 8 0 0
#4 iR-AMO06-VI | 0 0 4 2
Module register of slot #1
Module Register name Address (DEC) | Address (HEX)
iR-AQO4-VI | #0 Channel 0 Output Mode 20000 4E20
#1 Channel 1 Output Mode 20001 4E21
#2 Channel 2 Output Mode 20002 4E22
#3 Channel 3 Output Mode 20003 4E23
#16 Error Code 20016 4E30
#17 Command 20017 4E31
#18 Channel Detection 20018 4E32
Module register of slot #2
Module Register name Address (DEC) | Address (HEX)
iR-Al04-VI | #16 Error Code 20516 5024
#17 Command 20517 5025
#18 Channel Detection 20518 5026
#19 Conversion Time 20519 5027
#20 Channel 0 Input Mode 20520 5028
#21 Channel 1 Input Mode 20521 5029
#22 Channel 2 Input Mode 20522 502A
#23 Channel 3 Input Mode 20523 502B
#43 Channel 3 Minimum Value 20543 503F
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Module register of slot #3
There is no register related to analog input and analog output. Registers 21000-21499 are not used and

skipped.

Module | Register name | Address (DEC) | Address (HEX)

iR-DQ16-P

Module register of slot #4

Module Register name Address (DEC) | Address (HEX)

iR-AMO6-VI | #0 Channel 0 Output Mode 21500 53FC
#1 Channel 1 Output Mode 21501 53FD
#4 Channel 0 Scale Range Upper Limit | 21502 53FE
#19 Conversion Time 21519 540F
#20 Channel O Input Mode 21520 5410
#21 Channel 1 Input Mode 21521 5411
#22 Channel 2 Input Mode 21522 5412
#23 Channel 3 Input Mode 21523 5413
#43 Channel 3 Minimum Value 21543 5427
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Appendix A- Register Number
Register number for iR-Al04-VI, iR-AMO06-VI, and iR-AQ04-VI

Address | Description Default Read/Write 19 Conversion Time 0 Read/Write
20 i
0 Channel 0 Output Mode 1 Read/Write Channel 0 Input Mode 1 Read/Write
21 i
1 Channel 1 Output Mode 1 Read/Write RANnE 2 IBpUEMods n Read/Write
2 1 - 22 Channel 2 Input t Mode 1 Read/Write
Channel 2 Output Mode Read/Write
23 Channel 3 Input Mode 1 Read/Write
3 Channel 3 Output Mode 1 Read/Write
2 32000 24 Channel 0 Scale Range Upper Limit 32000 Read/Write
Channel 0 Scale Range Upper Limit Read/Write 25 Channel 1 Scale Range Upper Limit 32000 Read/Write
5 Channel 1 Scale Range Upper Limit 32000 Read/Write 26 Analog Channel 2 Scale Range Upper Limit 32000 Read/Write
Input
6 Channel 2 Scale Range Upper Limit 32000 Read/Write 27 Channel 3 Scale Range Upper Limit 32000 Read/Write
7 Analog Channel 3 Scale Range Upper Limit 32000 Read/Write 28 Channel 0 Scale Range Lower Limit -32000 Read/Write
8 Output Channel 0 Scale Range Lower Limit -32000 Read/Write 23 Channel 1 Scale Range Lower Limit -32000 Read/Write
9 Channel 1 Scale Range Lower Limit -32000 Read/Write 30 Channel 2 Scale Range Lower Limit -32000 Read/Write
31 imi I i
10 Channel 2 Scale Range Lower Limit 32000 Read/Write Channel 3 Scale Range Lower Limit 32000 Read/Write
32 . ; 5 Read /Wit
11 Channel 3 Scale Range Lower Limit -32000 Read/Write Channel O Filter Frame Size ad/Write
- 33 Channel 1Filter Frame Size 5 Read/Write
12 Channel 0 Update Time 0 Read/Write
13 Channel 1 Update Time 0 Read/Write 34 Channel 2 Filter Frame Size 5 Read/Write
14 Channel 2 Update Time 0 Read/Write 35 Channel 3 Filter Frame Size 5 Read/Write
36 i
15 Channel 3 Update Time 0 Read,/Write Channel 0 Maximum Value 0 Read
6 Error Code 0 Read 37 Channel 1 Maximum Value 0 Read
17 Command 0 Read/Write 38 Channel 2 Maximum Value 0 Read
18 Channel Detection FFh Read/Write 38 Channel 3 Maximum Value 0 Read
! 40 Channel 0 Minimum Value 1} Read
4 Channel 1 Minimum Value 1] Read
42 Channel 2 Minimum Value 1} Read
43 Channel 3 Minimum Value 1} Read
Register number for iR-Al04-TR
No. Description Default | Read/Write 23 Channel 3 Temperature Offset 0 Read/Write
0 h: 10 Mod 1 Read/Writ, .
Channe ode ead/write 24 Channel 0 Maximum Value 0 Read
1 Channel 1 Mode 1 Read/Write -
25 Channel 1 Maximum Value 0 Read
2 Channel 2 Mode 1 Read/Write
26 Channel 2 Maximum Value 0 Read
3 Channel 3 Mode 1 Read/Write
a Channel 0 Scale Range Upper Limit 32000 | Read/Write 2 Channel 3 Maximum Value 0 Read
5 Channel 1 Scale Range Upper Limit 32000 | Read/Write 28 Channel 0 Minimum Value 0 Read
6 Channel 2 Scale Range Upper Limit 32000 | Read/Write 29 Channel 1 Minimum Value 0 Read
7 Channel 3 Scale Range Upper Limit 32000 | Read/Write 30 Channel 2 Minimum Value 0 Read
8 Channel 0 Scale Range Lower Limit -32000 | Read/Write 31 Channel 3 Minimum Value 0 Read
] Channel 1 Scale Range Lower Limit -32000 | Read/Write
10 Channel 2 Scale Range Lower Limit -32000 | Read/Write
11 Channel 3 Scale Range Lower Limit -32000 | Read/Write
12 Channel 0 Filter Frame Size 5 Read/Write
13 Channel 1 Filter Frame Size 5 Read/Write
14 Channel 2 Filter Frame Size 5 Read/Write
15 Channel 3 Filter Frame Size 5 Read/Write
16 Error Code 0 Read Only
17 Command 0 Read/Write
18 Channel Detection FFh Read/Write
19 Celsius / Fahrenheit Setting 0 Read/Write
20 Channel 0 Temperature Offset 0 Read/Write
21 Channel 1 Temperature Offset 0 Read/Write
22 Channel 2 Temperature Offset 0 Read/Write

Note:

1. Scale range setting is only available for Voltage mode.
2. Temperature offset setting is only available for Temperature mode.
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Appendix B- Connecting iR-ETN to Codesys

Codesys is the world’s widely adopted IEC61131-6 standard industrial programming environment. You can
choose a Codesys platform from any manufacturer which supports Modbus TCP Master to control remote

IO on iR-ETN coupler.

Be Gt yew Puet FOADA, R Qi Debug Deds Windw B

08 Ie P TSRT Toolbar
Devices @ Rcor2 | Cavopen Manger @ etemet @ reoenr |G Modus TP Marer ] e prG 3 F Dewee L3
= ) Emecur s
= (@) Device (Werek Bult-n CODESYS)
= Bl retoge
= ) Apphcaton
I Jre— 5 .
o Variable Window
Device Window
oyt Program Editor Tool Box
@ #_coe_2 m<oe) xlaput
it N
[ oevoes [ e
soue S
= Emvecorven =l xinpac_3 xoacpu_3
O Prosctsetss ik {1
R L O
< >
Fre— B —— -ax
Home: [frace I RE RS Buid » [@ 0enorts |® 0 waming(s) [@ 0 messagets)| %
H yer - rariabie ceess ype ress  Loestion ject Besenption  Project Object Position
POU Window Symbol vou Vaiable A T Addem locsion  Objet e y
oy e
A —
Watch Window Message Window
> | | B massaces - Totaly 0 ererts), 0 warmiols), 0 massonts) (3 ot Tiee | fod v
PO T — [rm—— )

Here we use Codesys v3.5 platform from Weintek to demonstrate how it works. One Codesys soft PLC can
control multiple Modbus TCP slaves.

Device window:

o
CODESYS

Devices are listed hierarchically in Codesys project

=@ Ethernet (Ethernet) e Top level - Fieldbus adapter: Ethernet adapter
= [ Modous_TCP_Master (Modbus TCP Master) e 2nd level - Fieldbus Master (PLC is master)

:ﬂ Modbus_TCP_Slave (Modbus TCP Slave) . .
= sl e 3rd level — Fieldbus Slave (Coupler is slave
[ _tj Modbus_TCP_Slave_1 (Modbus TCP Slave) ( P )

25



Step1: Right-click [Device] on the Device window and select [Add Device]. Then select [Ethernet Adapter] »
[Ethernet]. Click [Add Device] button to add an Ethernet adapter.

Step2: Under the Ethernet adapter, create a Modbus_TCP_Master device. ([Fieldbusses] » [Modbus] »
[Modbus TCP Master] » [Modbus TCP Master])

Step3: Under the Modbus_TCP_Master, add a Modbus_TCP_Slave device. ( [Fieldbusses] » [Modbus] »
[Modbus TCP Slave] » [Modbus TCP Slave])

@ Add Device X
Name: [Ethemet
Action:
@ Append device () Update device
|:r':er a string for a fulltext search in all devices.... | Wendor: | <all vendors> hd
1 - Et h e rn et Name Vendor Version Description
= [ Feidousses
+ o CANbus
* e Ethercat
= BB Sthermet Adspter
[DEthemet | 35-Smart Software Souions GmibH 35100 Ethemet Link.
_ [ Add Device *
Devices -« 3 X
=) MTI0%0 RETN E] Name: [Modbus_TCP_Master
e Acton:
=-[B i Wei ilt-i Y
‘Jj EQVICE (Weintek Built-in CODESYS) (@ Append device () Insert device () update device
= [E pLC Logic
= £} Application [Enter 3 string for a fulltext search in al devices... | Vendor: | <all vendors> ~
m Library Manager Name Vendor Version  Description
[E] PLC_PRG (PRG = (@ Fedbusses
£] PLCPRG (PRG) 2. Modbus TCP Master 3 © Ehmtuee
= (&4 Task Configuration i
= & MainTask = W5 Modbus TCP Master
8] PLc_PRG [ Mocbus TCP Master | 35 - Smart Software Soubons GmbH .5.10.0 A device that we
= [ [Ethernet Ethernet) ¥ B Add Device X
= (i modbus_TCP_Master (Modbus TCP Mastd R ocbus,_ TGP Save
i Modbus_TCP_Slave (Modbus TCP Sla e
@ Appenddevice () Insert device O Updatedevice

[Enter a'string for a fuliext search i al devices.... | Vendor: |<allvendors>

3 . M od b us TCP Slave [ Nar_r'ue Vendor Version  Description
= 1) Fieldbusses
= 0 Modbus
= #m Modbus TCP Slave

[ Modbus TCP Slave. | 35 - Smart Software Soutions GmbH ~ 3.5.10.0 A generic Modbus ¢

1. Ethernet adapter-
Double-click [Ethernet]. On the [General] tab, click on [...] button nearby [Interface]. Then select “eth0”
[Use Operation System Settings]: Sets Ethernet adapter to DHCP mode.

[Change Operation System Settings]: Sets Ethernet adapter to Static IP. In this mode, you must enter IP
address and subnet mask.

Devices > 8 x [ Device (] Ethernet x
= [ Lintitedt "
= 7] Device [connected] (Weintek Buit-in CODESYS) | General X
Interface:
= 2 PleLogic
Status
= ) Application &) Use Operating System Settings
) Lrery wensger Ethemet Device [f0 Mapping Change Operating System Settings
] PLC_FRE (FRG)
= (@ Task Configuration Information 1P Address 192 .18 . 0 . 1
=2 M
& Marase Subnetmask /5 . 25 . 255 . 0
o] pLc_PrG
= [§ Ethemet (Ethernet) Default Gateway 0 .0 .0 .0
=i Modbus_TCP_Master (Modbus TCP Master) S —
[ Modbus_TCP_Stave (Modbus TCP Slave) : a
Interfaces:
Nome Description IP Address
1o 127001
nst] 102552552
TP Addzess 192 168 . 2 . 108
Subnstmazk 255 255 252 . O
Diefanlt Gatewsy 103 168, 1 254
MAC Address 000C:26 OF E6:FF
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2. Modbus TCP Master-

On the [General] tab, check [auto-reconnect]. The Modbus TCP Master will re-establish the connection if a

communication error happens.

Devices v R X @ Device 4 Ethernet
=13 Untitled1 >
= (#) Device (Weintek Built-in CODESYS) General
= B Pic Logic
L Q Application ModbusTCPMaster /O Mapping

m Library Manager
d¥] PLC_PRG (PRG)
= E Task Configuration

ModbusTCPMaster Parameters

Status

4 Modbus_TCP_Master X
Modbus-TCP

Response Timeout (ms) 1000

Socket Timeout (ms) 10

[¥] auto - reconnect

= @ MainTask
@] pLC_PRG
= 3 Ethernet (Ethernet)
= :ﬂ Modbus_TCP_Master (Modbus TCP Master)
@ Modbus_TCP_Slave (Modbus TCP Slave)

Information

3. Modbus TCP Slave-

On the [General] tab,

[Slave IP Address]- Enter IP address of the iR-ETN.

[Unit-ID]- Modbus Node ID of the iR-ETN is 1.

[Port]- is TCP port used for communication. Modbus TCP port is configured to 502 by default.

Devices * 4 x 4 Device ([ Ethernet )  Modbus_TCP_Master 4] Modbus_TCP_Slave X
=31 Untitled E]
=) Device (Weintek Built-in CODESYS) General ModbusTCP
=B Pic Logic
- £ Application Modbus Slave Channel Slave IP Address: 192 .168 . 0 . 1

m Library Manager
A PLC_PRG (PRG)

Modbus Slave Init Unit-ID [1.247)

— Response Timeout (ms) 1000
= [ Task Configuration ModbusTCPSlave Parameters
By Port 502
& MainTask
& pLc_PRG ModbusTCPSlave I/0 Mapping

= _d Ethernet (Ethernet)
= () Modbus_TCP_Master (Modbus TCP Master)
j Modbus_TCP_Slave (Modbus TCP Slave)

Status

Information

On the [Modbus Slave Channel] tab, configure Modbus channels. Each channel contains a Modbus
command that will be sent to the Modbus slaves. Click [Add Channel] button to add channels.

Name Access Type Trigger READ Offset  Length  ErrorHandling WRITE Offset  Length  Comment
0 SlotlInput Read Discrete Inputs (Function Code 02) Cydic, t=100ms 1620000 8 Keep last Value
1 Sot1Output  Write Multiple Coils (Function Code 15) Cydic, t#100ms 1620000 8
2 Slot2 Input Read Discrete Inputs (Function Code 02) Cydiic, t=100ms 1620008 8 Keep last Value
3 Slot2 Qutput Write Multiple Coils (Function Code 15) Cydic, t=100ms 1620003 8
MadbusChannel X
Channel
Name Siot1 Input
Access Type Read Discrete Inputs (Functon Code 7) g
Trigger Cyaic | cydeTime(ms)  [190
Comment [
READ Register
offset [owo000 - Add Channg]... Delete... Edit...
Length .3
Error Handling Keep last Value o
'WRITE Register
Offset
Length
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ModbusChannel

Channel

Name

Access Type Read Holding Registers (Function Code 3) w
Trigger Cydic ~| Cycle Time (ms)
Comment | |
READ Register

Offset [0x0000 |

Errar Handling Keep last Value

WRITE Register

Offset 0x0000

Length 1

Cancel

[Name] - Channel name

[Access type]- Selection of the Modbus function code
[Trigger]- It determines if the command should be cyclic
(time-based) or rising edge (trigger-based)

If cyclic is chosen, the cycle time must be set up for this
channel. If rising edge is chosen, the command is
executed on the rising edge event of a boolean variable
which is defined in [Modbus TCP slave I/0 mapping] tab.
[Comment]- You can enter a comment if needed.
[Offset]- The Modbus starting address. (hexadecimal
format)

[Length]- The number of the bits or registers

Read Register and Write Register are available based on
the function code you choose.

On [Modbus TCP Slave 10 Mapping] tab, you can map variables defined in this project to the IOs.

[ modbus_TcP_Slave x

Filter Show all

*p Appiication.PLC_PRG.XSW 1Auto
49 Application.PLC_PRG.XSW IManu
# Application.PLC_PRG.XPB1
*9 Application.PLC_PRG.XPB2
*p Application.PLC_PRG.xPB3
*p Application.PLC_PRG.xPB4

General Find
Modbus Slave Channel Variable
=
Modbus Slave Init =
ModbusTCPSlave Parameters
ModbusTCPSlave I/O Mapping
Status
Information
= "p
4
+ T

v

dy

Mapping Channel

‘\! ‘l i.! ‘! 6! @J

Address Type Unit  Description

Slot1 Input %IB0 ARRAY [0..0] OF BYTE Read Discrete Inputs
Slot1 Input[0] IEQ BYTE Read Discrete Inputs
BitD BeE8-0 BOOL Ox0000

Bit1 e BOOL 0x0001

Bit2 Sehke2 BOOL 0x0002

Bit3 SobeeS BOOL 0x0003

Bit4 e BOOL 0x0004

EitS Adhin s BOOL 0x0005

Eit6 YeIX0.6 BOOL 0x0006

Bit7 %IX0.7 BOOL 0x0007

Slot1 Output %QB0 ARRAY [0..0] OF BYTE Write Multiple Coils
Slot2 Input %lB1 ARRAY [0..0] OF BYTE Read Discrete Inputs
Slot2 Output %QB1 ARRAY [0..0] OF BYTE Write Multiple Coils

Transfer the project to the device by clicking [Build] and then [Login] on the toolbar. To run the program,
click on [Run]. The green circle marks on the device window indicate the devices are connected

successfully.

Onine Debug Tools Window Help
R E e AR

\

Login
Ctrl+F8

Build
F11

ne Debug Tools Window Help

\ﬁ!'ﬁ] oy

Logout / r ‘

Run Stop

- 3 Device [connected] (Weintek Bult-n CODESYS)
=84 Pic Logic
-  Application [run]
9 Library Manager
#] PLC_PRG (PRG)
®:% Symbol configuration
= (8 Task Configuration
= & MainTask
d] PLC_PRG
= < [@ Ethernet (Ethernet)
= (@ Modbus_TCP_Master (Modbus TCP Master)
(@ Modbus_TCP_Siave (Modbus TCP Slave)
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Appendix C- PLCopen XML

The PLCopen XML standardizes the way to exchange configuration files between development
environments. The export PLCopenXML is a tool to simplify 10 configuration in Codesys development
platform for iR-ETN and is available in EasyRemotelO version 1.2.0.15 or greater version.

How to Export PLCopen XML

Launch EasyRemotelO application and configure the IO modules.

il EasyRemotel0 - u] X
File Edit View Online Tools Help

S R i P T

Project Window g X
10/Modues  AddressMap  Parameter  Power Information
~ EF iR-ETN (192.168.1.212)
1. R-DMI6-N Channel Name Modbus Mapping Online Value Project Value ~
il 2 iR-DMIEP v #3 iR-AMOG-VI
il #3iR-AMOG-VI Product Code 0758
Firmuare Revision 0759
Hardware Revision OcTSfa
Power Consumption 0TS
Point of Digital Input OcT6le
Point of Digital Qutput 0761
Number of Analog Input 07620
Number of Analog Output 0x7621
Anzlog Qutput Error Mode #0 0x1815[0] Keep last velue
Anzlog Qutput Error Mode #1 0x18151] Keep last velue
Anzlog Qutput Error Value #0 0x1819 []
Anzlog Output Error Value #1 Ox181a [}
Output Mode £0 0x5208 10V
Output Mode #1 0x5208 +10v
Output Scale Range Upper Limit #0 Ox520c 32000
Output Scale Range Upper Limit £1 0x520d 32000
Output Scale Range Lower Limit #0 0:5210 -32000
Output Scale Range Lower Limit £1 0x5211 -32000 v
< >
Log Message & x
Date Time Message
2019-07-23 1457:02.562 Auto scan is successfully completed.
2019-07-23 14:56:45.548 EasyRemotelO is started. ProductVersion:1.2.0.15

Go to [File] tab and click [Export PLCopenXML]

" il EasyRemotelQ

File Edit View Online Tools Help

- Open Ctrl+0 m' E"
.;. New Ctrl+N g x
E‘ Save Ctrl+5
"T‘] Save As
Export Tag
Export PLCopensML




The XML file includes all information about you IO modules. Click [OK] and save the XML file.

Channel Select

X

<

hd iR-ETH (192.168.1.212)
A Channel
1: iR-DM16-N.Digital Input

1: iR-DM16-N.Digital Output(R)

: iR-DM16-M.Digital Output(W)
2. iR-DM16-P.Digital Input

2: iR-DM16-P.Digital Output(R)

2: iR-DM16-P.Digital Qutput(W)
3 iIR-AMOE-VI.Analeg Input

3 iR-AMODE-VI.Analog Qutput

1

v Init

Life Guard Time

iBus Continue Run

RunStop Pin

¢ iIR-DM16-N.Digital Output Errer Mode
: iR-DM16-M.Digital Output Errer Value
¢ iIR-DM16-M.Digital Input Filter Time

~] 1: iR-DM16-M.Digital Input Filter Time

RRREREE

¢ iIR-DM16-M.Digital Input Filter Time
1: iR-DM16-M.Digital Input Filter Time
1: iR-DM16-M.Digital Input Filter Time
1: iR-DM16-M.Digital Input Filter Time
1: iR-DM16-M.Digital Input Filter Time
1: iR-DM16-M.Digital Input Filter Time
2: iR-DM16-P.Digital Input Filter Time
A 3 iR_NAATAD Minital Inmet Fikbar Time

Select All Unselect All

O Cancel

Note: The XML file can be imported into Codesys development platform v3.5.10. If your codesys version is
greater than v3.5.10, please do the following steps.
1. Openthe XML file on Windows Notepad.

2. Search for “<Version>3.5.10.0</Version>". The version number must match your current Codesys
version. For example, if your Codesys version is v3.5.12, please change it to
“<Version>3.5.12.0</Version>".

"I ETN_IO - Notepad
File Edit Format View Help

<data name="Device" handleUnknown="discard">
<Device xmlns:xsi="http://www.w3.org/2081/XMLSchema-instance” xmlns:xsd="http://www.w3.org/2081/XMLSchema” xmlns="">

<DeviceType>
<Deviceldentification>
<Type»89</Type>
<Id>B000 ©085</Id>

Version»3.5.10.8</Version>

3. Save this XML file.
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How to Import PLCopen XML in Codesys

Launch Codesys and create a new project for Weintek Built-in Codesys.

Right-click [Device] on the Device window and select [Add Device]. Then select [Ethernet Adapter] »
[Ethernet]. Click [Add Device] button to add an Ethernet adapter.

Under the Ethernet adapter, create a Modbus_TCP_Master device. ([Fieldbusses] » [Modbus] » [Modbus
TCP Master] » [Modbus TCP Master])

Devices. -

=5 Unbied1
= m Device (Weintek Built-n CODESYS)
=2l PLC Logic
=-{Ck application
m Library Manager
HF| PLC_PRG (PRE)
= @ Task Configuration
= @ MainTask
& pLC_PRG
= E‘i Ethernet (Ethernet)
E‘i |Mndbus_TCP_Master (Modbus TCP Master) |

Click [Modbus TCP Master] and go to [Project] tab and click [Import PLCopenXML...]
& Untitled1.project™ - CODESYS

Eile

L

°m £

Ly O

Edit Wiew | Project | Build Online Debug Tools Window Help
Add Obyect X |84 % 5 1
Add Folder...

Scan For Devices...

Update Device...

Edit Object n CODESYS)
Edit Object With. ..

Online Config Mode...
Anager

(PRG)

Project Information. .. iguration

Set Active Application

Project Settings... ask

Project Environment. .. C_PRG
th

Project Localization 4
Master (Modbus TCP Master)

Document...
Compare...
Expaort...
Impart...

Export PLCopenXML...

Import PLCopenXML. ..

User Management 4
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This dialog prompts you to insert the iR-ETN device under [Modbus TCP Master]

Centents  Additional information

Please select the items which should be imported.
Allitems will be imported below the node which is currently selected in the navigator.
You can change this selection while this dialog is open.

Currently selected target object: Modbus_TCP_Master [Device: Ethernet]
Insertable items:

(@ irE™ (192.168.1212)

Select > Deselect > Show Contents... Cancel

The iR-ETN configuration is populated in the device tree.
@ Untitled1.project™ - CODESYS

Flle Edit View Project Buld Ornline Debug Tools Window

S dh 2

Devices -
=5 Unbitled]
= ﬂ'i Device (Weintek Built-in CODESYS)
=B PLC Logic
=} Application
m Library Manager
¥ PLC_PRG (PRE)
= @ Task Configuration
=38 MairTask
H] PLC_PRG
= ﬂi Ethernet (Ethernet)
= ﬁ Modbus_TCP_Master (Modbus TCP Master)
[ [r_E_192_168_1_212_(Modbus TCP Slave) |

Double click [Modbus TCP Slave] and enter the Unit-ID on [General] tab.

Devices - B x [ Device [{J R_ETN_192 168 1 212 X
=il Lngitled! i
= i . General
m Device (Weintek Built-n CODESYS) Modbus-TCP
T8l PcLone Modbus Slave Channel
. odbus Slave Channel .
=€} Application Slave IP Address: 192 . 188 . 1 .212
m Library Manager Modbus Slave nit Unit-ID [1..247] [ l
PLC_PRG (PRG) Response Timeout {ms) 1000
=[5 Task Configuration ModbusTCPS|ave Parameters Port 02
= g MainTask °
@ PLC_PRG ModbusTCPSlave I/O Mapping
= m Ethernet (Ethernet)
= [{ Modbus_TCP_Master (Modbus TCP Master) Status
[ R_ETN_192_168_1_212_ (Modbus TCP
Information
Genereal

. Click [OK] to confirm.
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Devices -~ B x ([ R_ETN_192_168_1_212_ x

2 %‘bg:; (Weintek Builtin CODESYS) General Neme Access Type Trigger READ Offset  Length  ErorHandlng ~WRITEOffset  Length  Comment
= [0 pLC Logic 0 1:iR-DM16-N.Digital Input Read Discrete Inputs (Function Code 02) Cydic, t#100ms 1630000 8 Keep last Value
=€} Application Modbus Slave Channel 1 1:R-DM16-N.Digital Cutput(R)  Read Coils (Function Code 01) Cydic, t#100ms 1650000 8 Keeplast Value
) Library Manager I, 2 1;R-DM16-\.Digital Output(W)  Write Multile Coils (Function Code 15) Cydic, t#100ms 1620000 8
R PLc_PrG PRG) 3 2:R-DM15-P.Digital Input Read Discrete Inputs (Function Code 02) Cydic, t#100ms 1650008 8 Keep last Value
= [&8 Task Configuration TS T R ITE S 4 2:iR-DM16-P.Digital Output(R) Read Coils (Function Code 01) Cydic, t#100ms 1640008 8 Keep last Value
= & MainTask § 2:R-DM15-P.Digital Output(W)  Write Multiple Colls (Function Code 15) Cydic, t100ms 16520008 8
&) Pc_rrG ModbusTCPSIave /0 Mapping 6 3:iR-AMDB-VI.Analog Input Read Input Registers (Function Code 04) Cydic, t#100ms 1620000 4 Keep last value
=@ Ethemet (sthernet) 7 3 R-AMOSLAnalog Output  Read/rite Multiple Registers (Function Code 23)  Cydlic, t#100ms 1650100 2 KeeplastValie 160100 2
=[] Modbus_TCP _Master (Modbus TCP Master) Status
(H R_ETN_192_168_1 212_(Modbus TCP Siave)
Information
Modbus Slave Channel
Devices v 3 X [# R_ETH_192 168 1 212_ x
=4 Untted! -
%[ Device (Weintek Bult-n CODESYS) General Line  Access Type WRITE Offset Default Value  Length  Comment
=20 PLC Logic 1 Write Single Register (Function Code 0&) 16#0%17d4 (=6100) 0 1
= £} Application Modbus Slave Channel 2 Virite Single Register (Function Code 08)  1620x273d (=10045) 1 1
i) Library Manager Modbus Save Int 3 Write Single Register (Function Code 08) 15200400 (=1200) 0 1
fiF] PLC_PRG (FRG) 4 Virite Single Register (Function Code 08)  150x17d5 (=6101) 65535 1
= {#8 Task Configuration T —— 5 Write Single Register (Function Code 06)  1620x 175 (=6133) 0 1
= MainTask 6 Write Single Register (Function Code 08)  1620x13ec (=5100) 0 1
@ PLC_PRG ModbusTCPSlave I/0 Mapping 7 Write Single Register (Function Code 06} 160x13ed (=5101) 0 1
= [ Ethernet (Ethernet) ] Write Single Register (Function Code 08)  15%0x13ee (=5102) 0 1
= ﬂi Modbus_TCP_Master (Modbus TCP Master) Status 9 Wirite Single Register (Function Code 08) 16#0x13ef (=5103) 0 1
[ R_ETN_192_168_1_212_ (Modbus TCP Slave) 10 Write Single Register (Function Code 06)  1620x13f0 (=5104) 0 1
Information 11 wirite Single Register (Function Code 06) 1650%13f1 (=5105) 0 1
2 Write Single Register (Function Code 08)  1650x 132 (=5106) 0 1
13 Write Single Register (Function Code 08)  1650x13f3 (=5107) 0 1
4 Write Single Register (Function Code 06)  1620x13f4 (=5108) 0 1
15 Write Single Register (Function Code 06)  1620x13f5 (=5103) 0 1
% Write Single Register (Function Code 08)  1630x 13f6 (=5110) 0 1
7 Write Single Register (Function Code 08)  1650x13f7 (=5111) 0 1
] Write Single Register (Function Code 06)  1620x13f8 (=5112) 0 1
15 Write Single Register (Function Code 06) 1620138 (=5113) 0 1
0 Write Single Register (Function Code 08)  16%0x13fa (=5114) 0 1
2 Write Single Register (Function Code 08)  1650x 13fb (=5115) 0 1
2 Write Single Register (Function Code 08)  1650x5208 (=21000) 1 1
23 Write Single Register (Function Code 08)  1620x5208 (=21001) 1 1
24 Write Single Register (Function Code 08)  15¥0x520c (=21004) 32000 1
25 Write Single Register (Function Code 08)  15¥0x520d (=21005) 32000 1
% Write Single Register (Function Code 08)  16¥0x5210 (=21008) 33536 1
7 Write Single Register (Function Code 08)  15¥0x5211(=21008) 33536 1
3 Write Single Register (Function Code 08)  1620x5214(=21012) 0 1
2 Write Single Register (Function Code 08)  16#0x5215 (=21013) 0 1
30 Write Single Register (Function Code 08)  16%0x521c (=21020) 1 1
31 Write Single Register (Function Code 08)  1650x521d (=21021) 1 1
32 Write Single Register (Function Code 08)  1620x521e (=21022) 1 1
33 Write Single Register (Function Code 08)  1620x521F (=21023) 1 1
34 Wirite Sinale Redister (Function Code 061 1650%5220 (=21024) 32000 1
Mave up Move down

Modbus Slave Init(Initial)
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Reference Link:
Weintek Labs website: http://www.weintek.com

CODESYS® is a trademark of 3S-Smart Software Solutions GmbH. Windows is a trademark or a registered trademark of
Microsoft Corporation in the United States and/or other countries.

Other company names, product names, or trademarks in this document are the trademarks or registered trademarks of their
respective companies.

This document is subject to change without prior notice.

[e

WE!NTEK Founded in 1996, WEINTEK LABS is a global-leading HMI manufacturer and is dedicated to the
wwweneusacon — @velopment, design, and manufacturing of practical HMI solutions. WEINTEK LAB’s mission is
to provide quality, customizable HMI-solutions that meet the needs of all industrial automation
requirements while maintaining customer satisfaction by providing “on-demand” customer service.
WEINTEK LABS brought their innovative technology to the United States in 2016, WEINTEK USA, INC,, to
provide quality and expedient solutions to the North American industrial market.

www.WeintekUSA.com
6219 NE 181s Street STE 120
Kenmore, WA 98028
425-488-1100
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